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Linda was originally scheduled to appear in March, but wintery conditions

forced the cancellation of that meeting.
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The Basics of Microsoft  Access

L
inda Oltz will provide us with
an opportunity for quick and
easy learning.

Access has many more
uses than the average
Office user realizes. 

Learn how to create: 

* Simple databases

* Forms

* Reports

Linda Oltz works in the 

Learning Center at the Utica 

School of Commerce’s operation 

in Canastota. She previously was a self-employed 

computer software training consultant. Linda’s specialty is

Human Resource/Payroll Software, specifically ABRA.

Welcome New Members
Fran Donovan

Herb Lavin

A new feature

 on our website 

— Links of Interest —
Go to: 

mvpcug.com/index1.htm

   * BC Schools Access2000

   * Access Functions

 Click on the links to find out  
more about these subjects.

Meeting Agenda

5:30 . . . . . . Meet and Greet

6:00 . . . . Business Meeting

6:30 . . . . . . Program, Part 1

7:00 . . . . . . . . . . . . . . Break

7:15 . . . . . . Program, Part 2

8:15 . . . Drawing for Prizes

8:30 . . . . . . . . Adjournment
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The MVPCUG EXPLORER is published

monthly from September through June by the

Mohawk Valley Personal Computer User Group,

Inc., PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and

are not reflective of the MVPCUG, nor are they

considered substantiated by inclusion in this

newsletter. All articles are copyrighted by their

respective authors but may be reprinted by other

User Groups provided credit is given to the author

and this publication.

The Mohawk Valley PC User Group, Inc.

(MVPCUG) was founded in 1981 by individuals

interested in IBM compatible computers. This non-

profit organization consists of volunteers whose

expertise range from novice to professional.

Regular meetings are held on the first Tuesday

of the month at 6pm, usually at the Whitesboro

High School, Route 291, Marcy NY. A typical

agenda consists of discussion of business affairs

and a demonstration of computer related products.

Meetings are open to the public.

Initial membership fee for an individual is $25.

Annual renewal dues are $20.
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4780 Commercial Drive - New Hartford
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ADVERTISING RATES
¼  page — $25   e   ½  page — $45
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Smart Computing Special
MVPCUG members can now enjoy special

benefits and pricing from the publishers of Smart
Computing, CPU, PC Today, and CE Tips.
Subscribe to one magazine and have access
online to all four publications!
i Smart Computing — For all skill levels, the

plain-English writing style will help you
improve your PC productivity and get the
most out of your computer. For more info,
visit www.smartcomputing.com.

i Computer Power User — For the high-end
power user with a taste for cutting-edge
products and for those who enjoy the
challenge of mastering and implementing
new technologies.  For more info, visit
www.computerpoweruser.com.

i PC Today — Filled with practical Windows
advice that PC users can put to work
immediately. Step-by-step tutorials, the
latest operating system news, hardware and
software reviews, and PC gaming. For more
info, visit www.pctoday.com.

i CE Tips — Covers the world of consumer
electronics from HDTV to your digital
camera. For more info:  www.cetips.com. 

For every five paid subscriptions MVPCUG
will receive a free subscription. Members family
and friends can order subscriptions . The unique
code numbers to use when calling (800)
733-3809 to order are:
i Smart Computing: 12659
i CPU: 935
i PC Today: 570
i CE Tips: 415

GET A FREE MVPCUG MEMBERSHIP

* It’s easy to do and you’ll save $20.00!

* Sign up two new members and you re-
ceive a one-year membership extension.

* You have 90 days in which to sign up

http://www.mvpcug.com
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The MVPCUG general meeting was held at the Whitesboro
High School. President Jerry Finkelstein called the meeting to
order at 6:00 PM. There were 48 persons in attendance.

BUSINESS MEETING
Treasurer Bill Gorrell reported that income was

$354.10, expenses were $513.40, and there is a
balance of $3,931.48 as of March 31, 2005.

There was no meeting March 1, 2005 due to bad
weather which closed the school.

Jerry Finkelstein spoke about the Photoshop SIG
which meets on the 3  Monday of the month fromrd

1:00 to 2:30PM at St. John’s Church in Whitesboro.
Although we work mainly with Photoshop, all ques-
tions about digital photography will be entertained.

Members are being encouraged to bring computer
related items to sell at meetings. Helen Russell took
advantage of the opportunity and sold an item within
minutes. All responsibility remains with the seller.

Kay Janowsky asked for a report on Tim Clinehen’s
condition and Dave Askew said that he had been in
contact with Tim who is staying with his brother in
Indiana. Tim had staples removed last week; is still
recuperating, and after a checkup within the next
month or so should be returning to his home.

We then moved into the Question and Answer period
with questions mainly about digital cameras.

PROGRAM
At 6:30 PM, Jeff Berman began his program on

Digital Cameras in Action. He gave specifics about
several cameras that he passed out to members of the
audience and encouraged everyone to investigate the
cameras and take pictures. Jeff then took several
photos and after the break he transferred them to the
computer and showed how to manipulate them using
the program ACDSee. Jeff said the best place to buy
lithium batteries was at www.sabahoceanic.com. The
presentation concluded at 8:15 PM

DOOR PRIZES

[furnished by Sam’s/Que’s Publishing Cos]
Beginner’s Guide to WordPerfect 11 Fred Schmandt
Windows XP in a Snap . . . . . . . . . Stuart Schwartz

[furnished with club funds]
DVDs 5 pack . . . . . . . . . . . . . . . . . . . Howard Esty
4x6 Staples photo paper . . . . . . . . . . . Gary Virkler
4x6 Fujifilm photo paper . . . . . . . . . . . . Herb Lavin
Best Buy certificate $25 . . . . . . . . . . Donna Gorrell
CD wallet . . . . . . . . . . . . . . . . . . . . . . . Dan Evans

[donated by Jerry Finkelstein]
Post It notes . . . . . . . . . . . . . . . . Marina O’Grady

[donated by Donna Gorrell]
PaintShopPro 5 book . . . . . . . . . . . George Purpura

[donated by Rod St.Clair[
Norton Antispam 2004 . . . . . . . . . . . Helen Russell

The meeting adjourned at 8:30 PM.

Respectfully submitted,
Donna Gorrell, secretary ˜

Photo taken at April meeting
by Lou Barile

“Smile, you’re on Candid Camera”

Minutes of April 5, 2004

— Donna Gorrell, Secretary  

http://www.sabahoceanic.com


Word Processing Tips
— by Bob Schaffer  
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WORD — View two places at once by splitting
the screen (Word 97/2000/2001/2002/2003) 

When you’re working with lengthy documents, it
can be difficult to move or copy items from one place
to another when the source and destination are far
apart. To make this simpler, try splitting the active
document window so you can view and edit two parts
of your document at the same time. To do so:
* Double-click on the split box (the tiny rectangular

box located at the top of the vertical scrollbar). 
* As an alternative, choose Window | Split, and then

click where you want the split to appear. 
* Word splits the document window horizontally into

two panes. 
* Each pane has its own scrollbars, so you can

navigate to different parts of the same document in
each pane. 

* For example, you can select a passage in the top
pane, and then drag it to the bottom pane to move
it to a new location. 

* To remove the split, double-click on the split bar
that separates the two panes, or choose Window |
Remove Split.
—  Viewing and navigating documents (2000,

2002, 2003)
* To see two parts of a document simultaneously,

drag the split bar at the top of the scroll bar.
* To view a document’s organization and jump to

different sections, click Document Map on the
View menu.

* To see the same document in two different views,
click Split on the Window menu, and then choose
the views you want.

* To display page margins, click Options on the
Tools menu, and then on the View tab, under Print
and Web Layout options, select the Text
boundaries check box. 

* To move to the previous or next word, press
CTRL+ LEFT arrow or CTRL+ RIGHT arrow.

* To go to the beginning or end of a document, press
CTRL+HOME or CTRL+END.

* To select an entire document, press CTRL+A.
* To close all open documents, press SHIFT, and

then click Close All on the File menu.

WORDPERFECT — Insert a Graphic as a Full
Page Watermark

If you’re inserting a watermark graphic into your
document and you want it to fill the entire page,
there’s an easy way to resize it without having to use
the graphic box sizing handles.

To do so:
* Open a new document.
* Choose Insert | Watermark.
* In the Watermark dialogue box select the

Watermark A option button.
* Click Create.
* Choose Insert Graphics and select either Clipart or

From File from the submenu. 
* Select the graphic file and click Insert.
* The watermark now fills the entire page of the new

document.
— Repeat a table’s header row over several

pages
When you create a lengthy table that spills over

onto the next page, WordPerfect does not display the
table’s headings at the top of each page that contains a
portion of the table. This can make multi-page tables
hard to read.

However, you can easily configure WordPerfect to
repeat a table’s heading row or several rows wherever
the table breaks across pages. To do so:
* Right click on the row that you want repeated on

each page.
* To include several rows, first select them, Right-

click on the selection and choose Format from the
QuickMenu.

* In the Properties For Table Format dialog box,
click on the Row tab if necessary.

* Select the Header Row (Repeats On Each Page)
check box in the Row Attributes panel.

* Click OK. ˜

Here’s a Neat Tip!

Would you like to receive a
Word and WordPerfect Tip 
every week via email?

Send your email address to
rdschaffer@adelphia.net.
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. . that last month I told you to find your system
resources by going to Start|Run and typing
MSINFO32? Well, only on Windows98 will this work.
Windows XP does not give that information, most
likely because the system has been improved and it
differs in the way it handles resources. You can still
find a lot of information about your system, but re-
sources is not one of the items; sorry for any confu-
sion. I apologize for any trouble that you have from
my assuming that these tips will work on all systems.

. . that each month I dig through newsletters and
magazines and websites looking for hints and tips to
print? I find what I hope are interesting or informative
tips that will make your ((and my) life easier. Thanks
to Kay, Bob K, Rod, Lou, Ed and others for their
encouraging words. Knowing that members appreciate
this work makes it worthwhile. I stubbornly hang on
to Windows 98, refusing to update when I find no
need to disturb my totally adequate computer just to
have the latest and greatest. (If it ain’t broke, why fix
it.) By doing this, I may miss out on some features and
am appealing to you all to send me any tips that you
find useful for another operating system.

. . that there is a program that can take the place of
MS Paint? Paint.NET is a paint program designed
entirely by students of Washington State University
and written using Microsoft’s .NET Framework. It
maintains the best features of the original MSPaint
application and includes new, powerful tools such as a
history storage for undos and redos and multi-layering
which is often seen only in high-quality photo applica-
tions. The program supports multiple layers with
transparency; drawing, painting, and selection tools; a
clone brush; and special effects like motion blur,
red-eye removal, and oil painting. Unlike Paint, it lets
you specify the compression/quality level when saving
a JPEG. A nice feature is that the palettes turn trans-
parent when you’re not using them, so you can see the
picture canvas underneath. Paint.Net can replace Paint
or live in harmony alongside it. Paint.Net is free.
Download it at: www.eecs.wsu.edu/paint.net/

. . that you could be in danger of losing all your doc-
uments? If you have accepted the default file “My

Documents” to use for all your data files you should
know that reinstalling Windows will overwrite that file
and all your data will be gone. I have a hard drive that
is partitioned with Windows system files and program
files on C:\. All other files are on D:\. I have a file on
D:\ named “Documents” in which I keep most of the
data files. All programs allow you to alter the place
where files are saved. Check out Options or Prefer-
ences or Settings in your program to find out where to
make the changes. Or use the Help to look for Saving
Files. You might also lose the partition if you do a
low-level format, but before doing any formatting you
should always backup your data. Under the main
folder “Documents” you can have subfolders to better
organize your data. Backing up one main file or sepa-
rating into the subfolders is easy to do and will save a
lot of heartache.

. . . that there is an excellent program you can down-
load for free that will print the directory files on your
computer? PrintFolder can be downloaded at several
sites, I used Tucows. This small program can find all
the files in your directories and sub directories and
will generate a file in plain text or HTML. I chose to
save the file as HTML with tabs. This file opened in
Netscape and I then Selected All from the Edit menu
and copied it into WordPerfect. I then changed the
font and margins and set the tabs to my liking. I now
have a full list of all the files in my D:\\Document
folder. This is no small task as it is 30 pages long
using size 9 Arial font, so you can image just how
many files I have in that one directory. I am doing
some Spring cleaning and including the computer as
one of the things to clean out. This list gives me all the
info I need to weed out some unnecessary files. The
real reason I was interested in printing a list of files
was to get my photographs organized. I have scanned
many old photos, plus having all my digital camera
files. I’m sure you can image the fun(?) I’m having
sorting out and trying to organize the whole mess. I’d
like to get the photos into folders that are meaningful,
but unless you have the names right in front of you it
can be very difficult. I have over 500 photos from my
camera alone and those are original straight from the
camera. I’ve renamed them all and diddled around
with most (you know, red eye removal, cropping, and
adding text to some). After I do my document files
and the photo files, I plan to organize my genealogy
files . . . see you sometime soon, maybe! ˜

  Did You Know . . .
— Donna Gorrell   

http://www.eecs.wsu.edu/paint.net/
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May is the month of new beginnings: flowers, green
grass, long days. Apparently, spring is also a time for
celebrities to unveil new bodywork. If you are
interested in new looks, visit
www.awfulplasticsurgery.com to view the new images
of Britney Spears, Steven Tyler, Latoya Jackson and
Marg Helgenberger. This site chronicles attempts by
celebrities to do more with more or more with less, as
the case may be. My take on the new bodywork is that
these celebrities should have saved themselves money
and time since the efforts to look better appear to have
been unsuccessful (except, of course, for Britney’s
enhancement to a 36 double E). The site also provides
definitions of plastic surgery terms so that should you
consider having the same work done, you will know
what to ask for. For example, blepharoplasty is the
term for the plastic surgery procedure that corrects
aging eyelids. If an alert, rejuvenated look is what
you’re going for, blepharoplasty may be your
procedure of choice.

Another site to visit, as spring fever produces rising
sap, is weaselcircus.com. At this site you may
download free flash games, greeting cards, funny
pictures and animated fun pages. I chose to click on
some of the funny pictures such as: Osama’s Baby
Picture (a superimposed mug shot of Osama bin
Laden’‘s face on the body of a diaper clad monkey).
On this same page you can download software that
adds smileys to your email. (Those images are
certainly complimentary.)

Another funny photo pictures an elderly gentleman
wearing nothing but a Wal-Mart shopping bag. And
although there appear to be some similarities, this is
NOT an image of me! Finally, for those who care,
there is a photo of Bill Clinton proving that he still has
it.

From the absurd to the frontiers of science is a site
“where science meets fiction” at technovelgy.com.
The site encourages you to “explore the wide variety
of invention and ideas of science fiction writers”.
There are more than 775 examples available at (tek
novel gee) such as: armor, artificial intelligence,
clothing, culture, computers and lifestyles. Pick the

clothing topic and amazing links appear. In 1977
George RR Martin published Dying of the Light in
which the clothing worn by the characters changes
color depending upon the geographic location. “ . . .
Dirk watched her clothing slowly fade to a mottled
off-white and green to match the shade of the ground
she sat upon.” Just under the passage are three links to
modern advances in fabric development which use
nanoparticles and nanofibers.

For example, a recent press release with a photo
discusses a “self-cleaning fabric”—polymer film
sprinkled with silver nanoparticles under development
at Clemson University. The nanoparticles allow cloth
to shed any dirt by simply brushing it or by sprinkling
the soiled area with water. A second link presents a
news release about carbon fiber yarn that can be spun
to manufacture protective vests stronger than Kevlar;
bandages that contract to put pressure on wounds; and
artificial muscles powered by electricity that are much
lighter than current hydraulics. These related science
news stories prove that today’s science fiction is
tomorrow’s science fact.

For those who wish to try their luck separating bad
guys from good guys, try surfing to
www.malevole.com/mv/misc/killerquiz. When you
visit this site, a short animated screen asks if you can
“tell a coder from a cannibal”. The site then produces
pictures of both code writers and mass murderers and
you are to identify which is which. This is not a
particularly noteworthy site unless you are extremely
well informed about computer geeks as well as current
killers in the news.

Another site for technology geeks is
www.aunty-spam.com. On this site, a very useful one
I might add, the visitor learns that spam can infest
TiVo just as easily as it invades computers. To prove
it, TiVo is now testing pop-ups on viewers. The way it
works is that while the user is in the very act of
skipping ads, the pop-up ad pops up and remains on
the screen. When you visit you will learn also that
Yahoo Messenger is a target of a “very effective
phishing scam”. And those of you with VOIP can
obsess over whether you are in trouble by reading the
article “VOIP 911: Weakness in VoIP 911 system
Leads to Lawsuit against Vonnage.” There is a free
Aunty Spam newsletter you can sign-up for as well.

Until next month . . . ˜

  Sites to Visit on the ‘Net
— by John Hunter   

http://www.awfulplasticsurgery.com
http://www.weaselcircus.com
http://www.technovelgy.com
http://www.malevole.com/mv/misc/killerquiz
http://www.aunty-spam.com


Effective April 12, 2005 Microsoft

updates to XP will no longer work

unless you have SP2 installed.
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How to Create Photo Albums 

with PowerPoint 2000
Great news for those who have PowerPoint2000.

Photo Album is a standard feature in PP2003 but you
don’t need to upgrade just to get this feature. The
folks at Microsoft have listened to your desires and
are furnishing a download add-in program for free.

To download the add-in program, go to:
http://tinyurl.com/5a724. On the right side of page is
Hot Downloads: Photo Album for PowerPoint 2000.
Or go to: http://tinyurl.com/4ck47, which takes you
directly to the page to download photo album. File
Name: album.EXE. Download Size: 1015 KB.

Special designs for photo albums and the
PowerPoint Save as Web Page feature can help you
share images of a wedding, family reunion, or other
special occasion across the Internet or an intranet.
You can view photo albums in Slide Show view or
print your album.

After you’ve downloaded the add-in program, the
new PhotoAlbum Wizard appears in the File New
dialog box. To create a photo album, click New on the
File menu, click PhotoAlbum on the General tab, and
then click OK. In the dialog box that appears, specify
the location of the pictures you want and choose from
other options.

You can add pictures directly from a scanner or
digital camera. Once you’ve got the pictures you want
in the list, you can change their order and rotate them
if necessary, also add text boxes.

You then pick from a variety of layout and style
options for your photo album. You can choose the
number of pictures per slide and pick from a variety of
frame styles and design templates. Design templates
for photo albums are just like design templates for
PowerPoint presentations, but with festive elements
and backgrounds suggesting weddings, babies, or
scrapbooks.

You can also choose to have a caption for each
picture. By default, the file name of the picture is
entered into the caption. Once you create the photo
album by clicking Create, you return to PowerPoint,
where you can change the caption text. Note: Once
you have created the photo album, you cannot return
to the Photo Album dialog box to make changes to
photo album options. Make the changes you want
directly on the slides in PowerPoint, or create a new
photo album with the same pictures. ˜

It makes sense that we, as a PC User Group,
should be a bit ahead of the PC media in our concern
re current trends and looking to the future. We are,
after all, the front lines. As I mentioned at our last
March meeting, we started our SIG on digital
cameras, graphics, and photoshop software months
ago. It’s been awhile now since we had Jeff lined up to
give us his excellent presentation on working with
digital cameras. Pick up the latest PC magazines;
they’re hawking the pros of digital cameras, reviewing
printers and software so that you get the most bang
our of your megapixels. NPR is looking over my
shoulder right now and explaining why you should
look into camera options other than megapixels to get
great pictures. A five megapixal camera may get you
awful pictures if you’ve got a lousy lens. Of course we
in our Group already know that there's more to a
camera than its megapixels. Recommended: get online
and compare reviews. We may or may not have been
there first, but who’s competing? Our shared interests
are being aired over the radio and across all sorts of
Net, news, and PC media. 

PC World  tells us there are too many columns for
one magazine and refers us to their online edition to
get to columns that didn’t make it to hard copy. The
more complete PC World is found in their “dead tree”
version. Newsweek has recently added a sidebar of
recommended Blogs. They appear regularly in The
Technologist section of the newsweekly under “Blog
Watch.” The April 26 PC Magazine devotes pages and
pages to the “Best 100 Web Sites” as well as to 100
nifty “undiscovered” sites. I found Answers.com
(among others) interesting, certainly informative; it
gives answers to your questions, but it doesn’t provide
you with a list of links to other sites. And all media are
encouraging readers to try the new Google Maps site. 

When the time comes for us to get this newsletter
online, we’ll know others have led the way. We’ll
have many wonderful models to follow. ˜

 Byting Remarks
— Jerry Finkelstein   

http://office.microsoft.com/en-us/FX010857971033.aspx
http://tinyurl.com/4ck47
http://www.Answers.com
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